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4 I SAFe Context

The GMS project 1s using the Scaled Agile Framework (SAFe)

° Provides an approach to scale agile development practices for multi-team projects such as GMS

> Adopted at the start of development (PI 1)

Agile Architecture principles and practices are part of SAFe
> Goal: active evolution of system architecture & design while business features are developed
° Intentional Architecture & Emergent Design

° Architecture Runway



5 I Architecture in SAFe

The system evolves over the course of development through a balance between
° Intentional Architecture — Planned initiatives to guide the overall System design across teams & features
° Avoid redundant and conflicting designs
> Emergent Design — Development teams drive the design of solutions as part of feature development

° Based on the Agile Manifesto principle: The best architectures, requirements, and designs emerge from self-organizing teams!]
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6 I Architecture in SAFe

Architecture Runway: components, infrastructure, etc. needed to develop near-term features
> Developed by teams
> Guided by architects

» Enablers build up the runway

e

o Features use the runway to deliver faster
» Architectural Runway must be continuously maintained
Implemented now ... » Use Capacity Allocation (a percentage of frain’s overall

o- 10 Support. capacity in a Pl) for Enablers that extend the runway




7 1 Architecture Specification

The GMS architecture is developed incrementally each PI to support feature implementation

The architecture is documented using a small set of views

> Representations of the system focusing on specific concerns

° Adapted from the 4+7 1zew ModeM]

Logical View
> Focused on the high-level functionality provided by the System

> Overview diagrams (freeform), UML Class Diagrams and textual descriptions

Deployment View

° Focused on the design of the physical/virtual platform and deployment of software components

Scenario View
> Use Case Realization model developed during the Elaboration Phase
> Used as a reference, but not actively updated

o Likely to be replaced with a small set of light-weight scenarios
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9 | Logical View Layers

User Interface Layer

User Interface ll
Display

---------- AP| Gateway

The GMS software architecture can be organized into a set of

.

) .

121Y€f S Application Layer ‘\u Processing Orchestration ’ — ::
> User Interface — The User Displays, organized into User (sequences)

Interfaces, together with supporting components :

........................

> Application - The orchestration of services into processing
workflows that implement the core mission logic

Processing Service
Service Layer (Control)

Processing

° Service — Software functions supporting automatic processing ‘ S

Processing

Service
(Other)

workflows and User Interface interactions

> Data Access — Interface software providing access to persistent
data while encapsulating the underlying storage implementation — \

A4 B

> Framework - Shared project software providing common U\J Data Access ’ ‘ COI Data Model ’

1 i i Data Access Layer Service ;
support functions and implementing standard patterns ,

. Vo
Higher layers depend on lower layers g Daesioe <

__________________________

Framework Layer ‘ Control ’ ‘ PSC ’ ‘ Comms ’ ‘ OSD ’ ‘ Config ’




10 I Framework Layer — Object Storage & Distribution
Supports access to persistent data in the System, while encapsulating the underlying storage technologies

Includes
> Data Model — Object model for persistent GMS data

> Data Services — Access methods exposed via the GMS Comms framework (JSON/MessagePack over HTTP)
> Data Repositories — Access methods exposed as a Java API

o Storage layer — Underlying Storage technologies and data model mappings

Storage Layer Technologies

> Postgres — Station reference, data acquisition and processing results (" Client Application Rk Client Application

> Apache Cassandra — Channel Segment data (raw & filtered waveforms, [ Cinpima Cllont ] [ Dals F?espository’
beams, FK timeseries) - L : A

A N7

6ata Service l .
Data Model
[ Comms Server ] Class I

\‘ Data Respository }/ -----------

User Interface Layer —
Anplication L Framework CRUD
pplication Layer
: \ SW ) CRU,D Operations
Service Layer Operations v
Data Access Layer COTS [ COTS Data Stores ]
Framework Layer h g




11 I Framework Layer — Comms

Supports network communication among components within and across layers of the System

Includes
> Network protocols and data encodings supported by COTS

o Java client & server encapsulating protocols and encodings

Supported communication patterns
> Request/Response

o Publish/Subscribe

Technolo gie S Client Application
> Request/Response: JSON & MessagePack over HTTP _ Comms Subscription
_ _ Comms Client | Client J
o Publish/Subscribe: TBD - X
Enables integration of components implemented in multiple l
1 HTTP request/response publish/subscribe
anguages (JSON or MessagerPack) (JSON or [ COTS Broker ]
MessagerPack)
User Interface Layer T
. Comms v
Application Layer Eramawork A 4
Service Layer p “ [ Comms Server ] [ Comms Publisher ]
Data Access Layer COTS

Provider Application

Framework Layer b




12 I Framework Layer - Configuration

Supports definition, loading, and runtime access to configuration settings

° Offtline definition in YAML files, supported by config tools and versioned as part of the GMS release process

° Loaded into persistent data stores as part of the runtime System

> Modifiable within the runtime System via the User Interface

Two types of configuration

1. System Configuration - Settings used for general application setup (e.g. DB connection parameters, logging levels)

2. Processing Configuration - parameters used to configure processing operations such as filtering, beaming, FK,
detection, association. Parameters can be defined and accessed for combinations of selection criteria (e.g. station,

channel, phase, source region, time of year, etc.)

AP| Gateway

‘ Config Client }

- Reégixz & Publish
Y Updates
User Interface Layer Service Application Retriove & v
ARBHRHON Ry [ COTS ] Cache Config Loader )- ------- >
Service Layer [ Conig Client J« ConT Bactand
Data Access Layer GMS SW Publish L Config Export + ........
Framework Layer / Updates

Config Support
Tools

Config Files



13 | Framework Layer - Control

Provides standard patterns and Java software supporting development of extensible components
deployed either as libraries within an application (e.g. processing workflow), or as standalone

applications accessed via service interfaces

Control Components

> Entry point for automatic processing business logic
> Filtering, beaming, FK, detection, association, location, magnitude, etc.

> Accessed from automatic processing sequences and Ul

Plugin Registry

Config
Client

|

~

/

Config
Framework

° Independent of other Control components éomm; Application
> Develop and replace in insolation
Data .
) ) Control Component
Plugins < > &
n
° Implement algorithms 2
) ) . ) ) Descriptors £ Data Access
> Bxtension point for new algorithm implementations » 8 e Client
i ry . ) LN
> Deployed as selectable algorithm within Control components \_
User Interface Layer Application
Application Layer Framework
Service Layer > N
Data Access Layer Other Data
4 Frameworks Service
Framework Layer ™ 4




14 I Framework Layer — Processing Sequence Controller

Supports orchestration of services into processing flows (e.g. station processing, network processing)

> Key extension point
> Processing flows support both automatic processing and User Interface interactions

° Supports multiple flow types, deployment models and data passing models
° Data-driven and interval-driven flows
° In-line and external service models

> Direct data passing (in-line or via network service) and Descriptor passing (similar to claimcheck pattern)

Implemented using Apache NiFi1
> Open-source orchestration framework for automated data processing flows

> Designed for scaling, fault tolerance, extensibility, security

User Interface Layer

Data Processing Wokflow
Externs In-Line Processing In-Line Processing
: Processing BEEE) Step 7 i | [ Step W ] o
: Step J Sort o
: Descriptors ava volvico ’ Java Service ’
: J P L Library Data Library Data

Application Layer Retrieve Data Store Retrieve Data Store

Service Layer for Descriptors Data for Descriptors Data COTS

Data Access Layer
‘ Processing Service Data Service GMS SW

Framework Layer




15 | Data Access Layer

Provides access to persistent data in the System via a Common Object Interface (COI) consisting of:
> Shared data model (Java classes, JSON or MessagPack)

° Data services for access via the GMS Comms framework (HTTP)

> Enables cross-language integration

° Java clients direct access (native protocols)

Encapsulates the underlying storage technologies, including physical schemas, query languages, etc.

Supports access from the User Interface, Application, and Service layers

. . o " .
Implemented via the Object Storage & Distribution (OSD) framework Cifnt Applicaion Client Application

[ Comms Client ] { Data F?espository’
- 4\ ! A

6ata Service l ) ‘W-

ata Model
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[ Comms Server ]
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Service Layer Operations v
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Framework Layer h g




16 | Service Layer

Processing functions available via well-defined interfaces

> Key extension points

° Orchestrated into processing workflows in the Application layer via the PSC framework

° Invoked from the User interface layer to support user interactions

> Implemented via the GMS Control framework

Network Service Interfaces

> Support direct data passing and descriptor pattern (JSON or MessagePack over HT'TP)

Examples

> Waveform QC, Filtering, Beaming, Signal Detection,
Signal Detection Association, Event Location, etc.

User Interface Layer

Application Layer

Service Layer

Data Access Layer

Framework Layer

-

/Contro! Application
Data o N
P g Control Component Plugin Registry
n
g Data A Confi l
Descriptors ata Access onfig
> § <> [ Client ] [ Client ] ?
Application
Framework |
Other Data Config
| Frameworks | Service Framework




17 I Application Layer

Orchestration of services into processing flows (e.g. station and network processing)
° Primarily Control components from the Service Layer

Supports automatic processing and User Interface interactions

Components may be embedded within the processing flow runtime or deployed as external applications
invoked via network interfaces

> External application model enables cross-language integration

Supports multiple flow types, deployment models and data-passing models
° Data-driven and interval-driven flows

o In-line and external service models

> Direct data passing (in-line or via network service) and descriptor passing (similar to claimcheck pattern)

Implemented via the Processing Sequence Controller framework (PSC)

User Interface Layer

Application Layer

Service Layer

Data Access Layer

Framework Layer
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18

Ul Layer — Overview

GMS User Interface composed of Displays, supported by an
API Gateway backend

° Current focus: Analyst User Interface

Displays support User interactions with the System

> E.g. Waveform Display, Signal Detection List, Event List, Map
Display, etc.

The API Gateway mediates interactions with lower layers
(Application, Service, Data Access) and provides UI support
functions

> Standard pattern popularized as part of Microservices
architectures

User Interface Layer

Application Layer

Service Layer

Data Access Layer

Framework Layer
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19 I Ul Layer - Displays

User Interface
Displays implement a shared design pattern
° Layout controlled via a Layout Manager \} f
. i L tM Display
> Access to shared Ul state and application data via a il J
UI Cache
> Access to processing functions (Application & . r:;ztsei:tm GraphQL
Service layers) and persistent data (Data Access Opetations
Layer) via the API Gateway f Ul Cache I dispatch
actions
Technologies O Ste |
° Language: Typescript L State Resolver — API Gateway Client
dat
> Web UI Framework: React Application Data PR cacne P
° Layout Manager: Golden Layout A

(o]

UI Cache: Redux
API Gateway Client: Apollo GraphQL client

o

Application Layer & mutations subscriptions

User Interface Layer cOTS
: GraphQL queries GraphQL

Service Layer GMS SwW

query cache / |

v v

Data Access Layer

[ API Gateway

Framework Layer




20 I Ul Layer — APl Gateway

Intermediary between the User Interface and lower

layers (Application, Service, Data Access),
providing:
> API consolidation, routing & composition

° Protocol translation

(o]

Data model views

o

User authentication & session management
Mocked backend

o

Technologies
° Language: Typescript
> Application framework: Node.js
> APIL: GraphQL (Apollo)

> GraphQL is an open-source data access language

User Interface Layer

Application Layer

Service Layer

Data Access Layer

Framework Layer

[ User Interface J

A
i GraphQL
GraphQL queries nG
& mutations subscriptions
A Y \
AP| Gateway [ Web Server ’

Session Manager 7

A

Y

Processor Pattern

i GraphQL
: E Schema

___________
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Architecture Overview -
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GMS Software Deployment

Docker containers provide the standard ,
deployment unit for GMS software components |

> Docker is a framework for packaging and deploying : EENESN | | (Docker EE Swarm) ‘E
application components | | [CMOSWhelease XY 111 (GMs sw Release X.Y D

: Vo " Ul Layer (partial) {1 |  gesseessecessssaccaccsnsccctoscsecasnenssosniaccdcncasas : !

> Docker Compose/Swarm is a framework for IS R yer (partial) o ; UI Layer (partial) ! !
dgﬁmng, deploylr}g, scaling and monitoring - | [ PR j ;
distributed container-based applications P Hiowsttion ¢ % _ :
i1 | |GMS SW Release X.Y I ! [ ki ] :

° Docker EE is a commercial distribution of Docker | || 22777777 B N :
. . b Ul Laper oartial) o Data Access Layer :

frameworks with licensed support P4 || Yitayer(partal ¥ 5

J| i [ Framework Layer j :

3 N y |

Each GMS deployment includes two primary

elements:

> A Processing Cluster (VM or server-based) built
using Docker Swarm

o A set of Ul workstations

Workstation N

...........................

Swarm node1
(server or VM)

S

—_—,———q
Local named
volumes

Swarm node2
(server or VM)

_— .
Local named
volumes

Swarm nodeN
(server or VM)

S

—_—
Local named
volumes
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GMS Software Deployment

The Processing Cluster hosts the following
layers of the application:
> UI (partial) — Includes the API Gateway and web

Server

> Application — The controller NiFi cluster with
deployed processing workflows

> Service — The set of replicated services
implementing GMS processing functions

> Data Access — The data stores (Postgres and
Cassandra), together with data services & clients
supporting access from the layers above

Workstations host part of the Ul layer,
including the browser & Desktop clients,
together with an optional copy of the API
Gateway

.
.

i GMS Release X.Y Deployment

Workstation 1

Browser (Chrome) Electron
[User Interface] [ User Interface]

(Optional)

Docker Container

AP| Gateway ul

I," Docker EE Swarm Cluster

Docker Container
Docker Container il
l Web Server (NGINX ] Layer
API| Gateway [ ( ) ve

Layer
Workstation 2
Browser (Chrome) Electron
[ User InterfaceJ [ User InterfaceJ
(Optional)

Docker Container

API| Gateway ui
Layer

EIControIIer (NiFi Cluster)

(Minions)

Workstation N
Browser (Chrome) Electron
[User Interface] [ User Interface]
(Optional)

Docker Container

AP Gateway ui
Layer

‘Master, N
( ) Application
Docker Container Docker Container Layer
NiFi Node NiFi Node
Vs N o N
%) 2
( - 7
Docker Container Docker Container Service
[Processing Service A] [Processing Service B] Layer
\§ J G J
e Y ( Y
) 2
- )\ e N
Docker Container Docker Container
[ Data Service A ] [ Data Service B ]
g g N J
Data
i Channel Segment Store (Cassandra Cluster) ‘ Access
' i Layer

A :
N\ ] Docker Container

Docker Container
[ Cassandra Node ]
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Platform Evolution

GMS platform development started with the Red Hat OpenShift container platform

Problems uncovered during early development caused the project switch to the Docker EE platform in PI 6
> OpenShift is an enterprise-scale product that 1s difficult to deploy and support for a single project

> High license cost

° Substantial support effort required (System team, consultants)

o Misalighment of core features

> Source-to-image designed for single container per service per repository

Docker EE experience so far
o Significantly reduced platform complexity
o Simplified deployment model

Transition
> PI 6: Single-node testbed deployment (Docker Compose)

o PI 7+: Clustered testbed deployment (Docker Compose, Docker Swarm)



Architecture Challenges




26 I Architecture Challenges

Architecture Runway
° The project has struggled to establish and maintain an architecture runway

° Lack of shared software frameworks & standardization has hindered development

Intentional Architecture vs. Emergent Design
> Over-reliance on emergent design eatly in development

o Insufficient architecture guidance has hindered development

Architecture Runway lag resulting in
excessive technical debt and rework

Now
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Project Response

Established a dedicated Architecture team in PI 5 focused on providing more rigorous architecture
guidance further in advance

° Higher-formality documentation and team hand-offs

Established a dedicated Frameworks team in PI 7 to accelerate development of the architecture
runway

o Shared frameworks improve reduce complexity and effort to develop application components

Framework Layer ‘ Control J ‘ PSC ’ [CommsJ ‘ OSDJ ‘ Config ’




Questions
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31 I Application Layer — Station Processing
Basic Station Processing flow under development

Starting design: interval driven with external services
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Application Layer — Network Processing

Initial Signal Detection Association flow development starting PI 7

o Investigation of data-driven vs interval-driven associator
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